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Important Information

Please read this manual carefully before setting up and using the Rear Projection SMART Board
2000i interactive whiteboard. With proper care, your 2000i should provide years of trouble-free
service.

WARNING The projector inside the unit is a high brightness light source. Do not look directly
into the beam of light. Prevent children from staring directly into the beam of light.

Le projecteur qui se trouve à l’intérieur de l’armoire est une source de lumière à
luminosité élevée. Ne fixez pas et ne regardez pas dans la direction du faisceau
lumineux. Empêchez les enfants de regarder dans la direction du faisceau
lumineux.

El proyector que se encuentra en el interior de la cabina es una fuente de luz de
alta luminosidad. No mire fija ni directamente al haz de luz. Evite que los niños
fijen la vista en el haz de luz.

Der Projektor im Schrank stellt eine Lichtquelle mit hoher Intensität dar. Blicken
Sie nicht direkt in den Lichtstrahl. Verhindern Sie, dass Kinder direkt in den
Lichtstrahl blicken.

キャビネット内のプロジェクターは、高輝度光源です。ビーム光線を覗き込んだり、直接
見たりしないでください。お子様がビーム光源を覗き込まないように注意してください。

WARNING Lock the casters and extend the anti-tip feet before you use the unit. Otherwise,
the 2000i could tip over. 

Bloquez les roulettes et étendez les pieds avant d’utiliser l’appareil. Autrement, le
2000i risque de basculer et de tomber.

Bloquee las ruedas y extienda los pies ajustables antes de utilizar la unidad. De
no hacerlo, la pantalla 2000i podría volcarse.

Sichern Sie die Rollenbremsen und fahren Sie die Sicherheitsstützen aus, bevor
Sie das Gerät verwenden. Andernfalls könnte das 2000i umkippen.

ユニットをご使用になる前に、キャスターをロックして、脚を伸ばしてください。
以外の場合は、2000i がひっくり返る可能性があります。

WARNING Make sure an AC socket outlet is near the 2000i and remains easily accessible
during use.

Assurez-vous qu’une prise secteur se trouve à proximité du 2000i et demeure
facilement accessible durant l’utilisation.

Asegúrese de que hay una toma de corriente alterna cerca del 2000i y que es
fácilmente accesible para su uso.

Stellen Sie sicher, dass sich in der Nähe des 2000i eine Steckdose befindet und
sie während der Verwendung auch leicht zugänglich bleibt. 
2000i
の近くに電源用のコンセントがあり、使用中に手が簡単に届くことを確認してく
ださい。
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WARNING To reduce the risk of fire or electric shock, do not expose this product to rain or
moisture.

Pour réduire le risque d'incendie ou de choc électrique, évitez d'exposer ce produit
à la pluie ou à l'humidité.

Para reducir el riesgo de incendio o de descarga, no exponga este producto a la
lluvia o la humedad.

Um das Risiko eines Feuers oder eines Stromschlags zu reduzieren, darf das
Produkt weder Regen noch Nässe ausgesetzt werden.

火事や感電の恐れがありますので、この製品は雨にさらしたり湿気のあるところに置か
ないでください。

WARNING for
European

Customers

The 2000i should only be used with European TN and TT power
distribution systems. 

The 2000i is not suitable for older, IT-type power distribution systems
found in some European countries. “This system (IT-type) is widely used
isolated from earth, in some installations in France, with impedance to
earth, at 230/400V, and in Norway, with voltage limiter, neutral not
distributed, at 230V line-to-line.” (IEC 60950:1999)

Contact qualified personnel if you're uncertain of the type of power system
available where you're installing your 2000i.

AVERTISSEMENT
pour les clients

européens

Le 2000i doit être utilisé uniquement avec les systèmes de distribution
d’alimentation européens TN et TT. 

Le 2000i ne convient pas aux systèmes de distribution d’alimentation plus
anciens de type IP utilisés dans certains pays européens. “Ce système
(type IT) est largement utilisé isolé de la terre, dans certaines installations
en France, avec une impédance à la terre, à 230/400V, et en Norvège,
avec limiteur de tension, neutre non distribué, à 230V ligne à ligne. “ (IEC
60950:1999)

Si vous avez des doutes sur le type de système d’alimentation disponible
lors de l’installation de votre 2000i, contactez un personnel qualifié.

ADVERTENCIAS
Para los clientes

europeos

La 2000i sólo se podrá utilizar con los sistemas eléctricos TN y TT
europeos. 

Este modelo no está disponible para antiguos sistemas eléctricos de tipo
IT que aún se utilizan en algunos países europeos. “Este sistema (IT)
tiene una utilización muy extendida como núcleo aislado de tierra; en
algunas instalaciones en Francia, con impedancia de tierra, a 230/400 V;
y en Noruega, con limitador de tensión, a 230 V entre conductores.” (CEI
60950:1999)

Si no está seguro del tipo de sistema eléctrico que posee, póngase en
contacto con personal cualificado a la hora de instalar su modelo 2000i.
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WARNUNG für
europäische

Kunden

Das 2000i darf nur mit europäischen TN- und TT-Netzverteilern verwendet
werden. 

Das 2000i eignet sich nicht für ältere Netzverteiler vom Typ IT, die in
manchen europäischen Ländern zu finden sind. “Dieses System (IT-Typ)
wird, von der Erdung isoliert, in einigen Installationen in Frankreich mit
Impedanz zu Erde bei 230/400 V und in Norwegen mit
Spannungsbegrenzer, neutral, nicht verteilt, bei 230 V Leitung zu Leitung
verwendet.“ (IEC 60950:1999)

Wenden Sie sich an qualifiziertes Personal, wenn Sie sich nicht sicher
sind, welches Stromsystem dort zur Verfügung steht, wo Sie Ihr 2000i
installieren.

ヨーロッパのお客様
への警告

2000i はヨーロッパの TN および TT
配電システムでのみ、使用する必要があります。 

2000i はヨーロッパの一部の国で使用されている旧式の IT
タイプの配電システムには適していません。「このシステム (IT
タイプ)
は、地面から離した状態で広く使用されていますが、一部フランスでは
230/400V
でインピーダンスを通して接地され、ノルウェイでは、電圧制限器によ
り中性非分散型で 230V のライン間電圧で使用されています」 (IEC
60950:1999)

2000i
をインストールする際に使用可能な電源システムのタイプに関して不明
な点がある場合は、担当者までお問い合わせください。

Other Warnings and Safety Precautions
For operating safety and to avoid damage to the unit, follow these instructions.

1. Move the unit with care. Quick stops, excessive force and uneven surfaces can overturn it.

2. When you transport the 2000i, only ship it in an upright position and never lay the interactive
whiteboard face down. 

3. If you transport the 2000i over a distance, we strongly urge you to completely repackage it
using the original packaging. This packaging was designed with optimal shock and vibration
protection. If the original packaging is no longer available, pack all components with as much
padding as reasonably possible to ensure that they are not exposed to excessive vibration or
shock.

4. Clean the interactive whiteboard surface on a regular basis. Otherwise, dust may build up on
the surface, adversely affecting the operation of the 2000i.

5. Do not touch the rear surface of the screen or apply isopropyl alcohol, water or acetone. If any
of these fluids come into contact with this surface, the diffusion coating will be damaged,
resulting in a permanent deterioration in display quality. 

6. If you inadvertently smudge the rear surface of the screen, wipe it carefully with a soft cloth
and alcohol-free glass cleaner. Do not spray the glass cleaner directly on the back of the
screen; spray it lightly on the cloth, and then gently dab the rear surface until the marks are
removed.

7. The 2000i uses digital cameras that are located inside the screen frame. Do not allow excess
glass cleaner to flow into the crack between the frame and the writing surface, because the
cleaner could damage these cameras.
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8. Avoid setting up and using the 2000i in an area with excessive levels of dust, humidity or
cigarette smoke.

9. Avoid exposing the 2000i to extreme heat or cold. The operating temperature range is from
41° F to 85° F (5° C to 29° C) with up to 80% humidity (non-condensing). The shipping and
storage range is from -4° F to 95° F (-20° C to 35° C) with up to 80% humidity (non-
condensing).

10. Unplug the unit during electrical storms or if you won't use it for an extended period of time.

11. This product has a three-wire grounding-type plug, which will only fit into an AC grounding-type
power outlet. Make sure an AC socket outlet is near the 2000i and remains easily accessible
during use. If you are unable to insert the plug into the outlet, have your electrician replace the
obsolete outlet. Do not circumvent the safety features of the grounding-type plug. 

12. Handle the power cord carefully and avoid excessive bending. Route the power cord so it’s
unlikely to be walked on or pinched by items placed upon or against it. Do not modify the
power cord.

13. If you require replacement parts, ensure the service technician uses replacement parts that are
specified by SMART Technologies Inc., or parts with the same characteristics as the original.
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About the 2000i-DVX 

The Rear Projection SMART Board 2000i interactive whiteboard is a height adjustable, rear
projection system with an integrated XGA LCD projector and a 67" (170.2 cm) diagonal interactive
SMART Super Screen. 

To enable rear projection capability, a mirror system redirects the projected image from your
computer, VCR, DVD player or guest laptop onto the back of the interactive whiteboard screen,
eliminating the distracting shadows that sometimes occur with a front projection system. You can
then perform any normal computer operation, such as opening or closing an application, scrolling
through a file, or opening your browser, just by touching the screen. If you’ve purchased the X-Port™
20 option, you can switch between three different projector input sources with the press of a Control
Panel button.

With SMART’s recently developed Digital Vision Touch (DViT™) technology, the 2000i uses digital
cameras to track objects on the interactive whiteboard. Each camera is calibrated to recognize the
position of a pen tray tool or your finger on the screen surface and to send this information to the
computer, which translates it as mouse clicks or electronic ink.

Features

• A touch sensitive, rear projection interactive whiteboard that enables you to do everything you
can do at a computer workstation − open files, conference with others, create new documents
or edit existing ones, visit Internet sites, play video clips, etc. − simply by touching the screen.
You can also write over any live application in electronic ink using a pen tray stylus or your
finger, and then save these annotations to a Notebook file for future reference and
distribution.

• An integrated 1300 ANSI lumens, XGA (1024 x 768) projector with short-throw lens

• An audio system and a pen tray (including four styluses and an eraser) 

• A Control Panel next to the pen tray with easily accessible projector, volume and source
switching controls. The Control Panel also provides button-press access to Notebook software
and the Floating Tools.

• A videoconferencing/laptop shelf

• A height adjustment handle that raises and lowers the screen from 69" (175.3 cm) to 83"
(210.8 cm)

• Audio jacks at the rear of the unit let you connect the audio output from a laptop, VCR, DVD
player or room audio system

• Minimal floor space requirements. The 2000i fits easily through any standard doorway for true
room-to-room mobility.



2 2000i-DVX Installation Guide

Getting to Know Your 2000i 

                                              Major Components of the 2000i

Projector

Lockable Casters (x 4)

Your Computer

Storage Tray

Extendable Anti-Tip Feet (x 4)

SMART Pen Tray

Control Panel

Laptop Shelf

Height Adjustment 
Handle

Removable View Port

Projector
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Pen Tray Features

  The Pen Tray

  

Using a Pen Tray Stylus Using the Pen Tray Buttons
To write over the computer image with
electronic ink, just pick up a stylus from the pen
tray and write on the screen.

You can use SMART Board software to change
any or all of these styluses to highlighters,
assign one of 16 colors to them, or alter their
width. You can also change the size of the area
erased by the pen tray eraser.

To reconfigure the styluses or eraser, click the
SMART Board icon in the system tray ,
select Control Panel, and click the Pen Tray
tab. 

NOTE: The provided styluses have black tips
because the digital cameras can more readily
detect dark objects. If you need to use a
different stylus, choose one with a dark tip.

Press the top pen tray button to make the
SMART Keyboard appear for on-screen typing
and handwriting recognition. Press the bottom
button to make the next contact with the
interactive whiteboard a right-click. 

You can reconfigure these buttons to perform
any of the following functions:

• print the current page

• move to the previous or next Notebook
page

• clear all annotations from the current
Notebook page

• produce a floating mouse

To reconfigure the pen tray buttons, click the
SMART Board icon in the system tray ,
select Control Panel, and click the Pen Tray
tab.

Eraser 
Black Stylus

Blue Stylus
Red Stylus

Green Stylus

Pen Tray Buttons
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The NEC VT560 Projector

CAUTION Do not move the blue ring that surrounds the short-throw, customized projector
lenses, even though the NEC VT660K/VT560/VT465 User’s Manual states that you
should use this ring to obtain the best focus. You must disregard this information,
because moving this ring may cause the lenses to separate. 

Instead, use the Zoom lever on the projector to adjust image focus. Again, contrary to
the NEC VT660K/VT560/VT465 User’s Manual, the Zoom lever will not adjust the
image size on the screen. 

The NEC VT560 projector is secured upside-down on the projector platform. For optimal performance
in the 2000i, the projector has been changed in two significant ways from the description of how it
works in the NEC VT660K/VT560/VT465 User’s Manual:

• The Zoom lever does not change the size of the projected image. Instead, it functions as a Focus
lever. 

• The blue ring no longer adjusts focus, and you should not move it under any circumstances.
Moving this ring may cause the lenses to separate.

NOTE: For more information on adjusting the projected image, turn to page 13.

Do not move this ring!

Bottom View (Upside-Down)

Side View

Adjust the focus with this lever
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Projector Settings

We've configured your projector settings for optimal performance with the 2000i. However, if these
settings are accidentally altered, follow the procedure below to restore them. 
To set or restore the optimal settings for the NEC VT560 projector

1. Press the Menu button on the projector remote control or on the projector (you’ll have to reach
under the projector).

2. Select Setup > Orientation > Ceiling Rear to orient the projected image for rear projection.

3. Select Image > Auto Keystone > Off to ensure optimal image quality.

4. Select Advanced > High Speed Fan Mode > Off. While this is a default setting, it’s sufficiently
important to warrant special mention.

5. Select Advanced > Page2 > Auto Adjust > On to automatically determine the best resolution for
the current RGB input signal, compensating for resolution differences among various input
devices (such as guest laptops).

6. Click OK.

NOTE: All other settings are the NEC factory default settings. See pages E-26 to E29 of the
VT660K/VT560/VT465 User’s Manual for a full description of all default settings. 

For information on projector maintenance and complete instructions on replacing the projector lamp
and filter, turn to page 37.

Using the Projector Remote Control 

The remote control for the NEC VT560 projector works best when you aim it at the area below the
pen tray. If you point it directly at the screen, it will have no effect. 

Taking Correct Aim with the Remote Control

Press the Menu button on the remote control to view the projector menu on the screen. Note,
however, that you can’t select the projector menu options by touching the screen; you must use the
remote control or the buttons on the projector itself.
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Control Panel 

Use the Control Panel to turn the projector lamp on and off, change the display source for the
projector, open Notebook software, and adjust the volume of the internal sound system.

                                                     The Control Panel

The Lamp On and Lamp Off Buttons

In normal operation, you should keep the projector powered up all the time. However, to conserve the
lamp, put the projector into standby mode at the end of your session (or at the end of the day). In
standby mode, the projector lamp is powered down, but the projector itself remains on. 

To put the projector into standby mode, press the Lamp Off button on the Control Panel. For the next
three minutes, the lamp is in a reversible standby mode in which the screen appears black, even
though the projector lamp remains on, allowing you to quickly restore the display by pressing any
button on the Control Panel. 

After three minutes, the lamp cools down for 60 seconds and then powers off. You can skip this
three-minute reversible standby period by pressing and holding the Lamp Off button for three
seconds. To power up the projector lamp, press the Lamp On button.  

For the current status of the lamp, check the LEDs beside the Lamp On and Lamp Off buttons, and
then check the table below.

On LED Off LED Lamp Status
Flashing moderately quickly Off Lamp is powering up. During this 60-second

period, the Lamp On and Off buttons are
disabled.

Solid Off Lamp is fully powered up.

Flashing occasionally (short
flashes followed by long
pauses)

On Lamp is off.

Volume Up

Internal Computer

Guest Laptop

Lamp Off

Off LED

On LED

Lamp On

VCR/DVD Player
Notebook 
Software

Volume Down
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On LED (Cont’d) Off LED
(Cont’d)

Lamp Status (Cont’d)

Off Flashing very
quickly

Lamp is in three-minute reversible standby mode.
In this mode, the screen appears black, even
though the projector lamp remains on, allowing
you to quickly restore the display by pressing any
button on the Control Panel. After three minutes,
the lamp cools down for 60 seconds before
powering off.

Off Flashing
slowly

Lamp is cooling down. This 60-second cooldown
follows the three-minute reversible standby
period. During this time, all Control Panel buttons
are disabled.

Volume Control Buttons 

Press the Volume Up (+) button to increase the volume and the Volume Down (–) button to decrease
the volume. The 2000i retains your settings for each source.

The default volume is 0. To restore this default, press the +  and  –  buttons simultaneously.

Source Buttons

You can use the source buttons to switch the video and audio sources for the projector and the
cabinet audio amplifier. Please note that switching sources takes a few seconds, and all buttons on
the Control Panel are disabled during that time.

Button Source

VCR/DVD player

NOTE: This button only switches the projector to the VCR/DVD player input when an
RCA composite video cable connects this equipment to the projector. If you used an
S-video cable, press the S-video button on the projector or the projector remote
control to switch to this video source. For more information on connecting a VCR or
DVD player, see page 25.

Internal computer

For information on installing the internal computer, see page 10.

Notebook software. The internal computer source must be active. For information on
using Notebook software, see page 35.

Press this button and hold it down for four seconds to open the Floating Tools. For
instructions on using the Floating Tools, see page 34.

Guest laptop 

NOTE: You can only switch to a connected guest laptop if your system includes the
optional X-Port 20 switch. 
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Installing Your 2000i
This section of the manual describes how to:

• set up the 2000i (page 8)

• install and connect the host computer (page 10)

• adjust the projected image (page 13)

• connect the videoconferencing/laptop shelf (page 20)

• install SMART Board software (page 22)

• connect a guest laptop (page 24)

• connect a VCR or DVD player (page 24)

• connect an external sound system (page 26)

• connect an external projector or monitor (page 27)

Setting Up the 2000i 

1. Remove the unit from its shipping carton. (To do this, follow the Unpacking Instructions.)

Unpack the remaining contents of the shipping carton and wheel the unit to a location that’s
within reach of a power source. Leave enough space around the unit to comfortably perform the
assembly and connection procedures in the pages that follow. 

2. Lock the casters by pressing down on the caster-lock tab; unlock the casters by pressing up on
this tab, as shown in the figure below. 

                    A Locked and Unlocked Caster

3. Extend all four anti-tip feet. You’ll see two holes on the outer side of each leg. To extend the feet,
depress the locking ball in the inner hole, and then pull the leg out until the locking ball engages
in the outer hole.

  Extending an Anti-Tip Foot 

  

Locking Ball in the
Inner Hole Locking Ball in the

Outer Hole
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WARNING Lock the casters and extend the anti-tip feet before you use the unit.
Otherwise, the 2000i could tip over. 

Bloquez les roulettes et étendez les pieds avant d’utiliser l’appareil.
Autrement, le 2000i risque de basculer et de tomber.

Bloquee las ruedas y extienda los pies ajustables antes de utilizar la unidad.
De no hacerlo, la pantalla 2000i podría volcarse.

Sichern Sie die Rollenbremsen und fahren Sie die Sicherheitsstützen aus,
bevor Sie das Gerät verwenden. Andernfalls könnte das 2000i umkippen.

ユニットをご使用になる前に、キャスターをロックして、脚を伸ばしてください。それ
以外の場合は、2000i がひっくり返る可能性があります。

4. Remove the bag that surrounds the projector.

5. Remove the locking pins from either side of the 2000i.

  Removing the Locking Pins
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Installing a Computer

To connect a computer

1. Slide the computer into place on the bottom storage shelf, above the computer straps, and then
secure the straps around the computer.

NOTE: The straps allow you to roll the unit from room to room without removing the computer.
However, these straps will not secure the computer in place during unit shipment. If you ship the
unit, remove the computer first.

2. Locate the bundle of labeled cables (to the right of the projector) hanging down towards the
storage tray.

Computer 1 Audio

Computer 1 Video (Male)

Computer 1 Serial (Female)

2000i AC (Male)
(Connect to female country-specific AC cable)

  Computer and Power Cables

3. Connect the Computer 1 Video cable to the Monitor Video connector.

4. Connect the Computer 1 Audio cable to the Audio Line OUT connector.

5. Connect the Computer 1 Serial cable to an available COM port.

NOTE: To connect a computer that has no available serial port, connect the SMART USB
adapter (supplied in the accessory kit) between the Computer 1 Serial cable and the USB port
on the computer.

6. Connect the Mouse and Keyboard cables (not supplied) to the PS/2 mouse port and the PS/2
keyboard port on the computer.

To connect the power cables 

1. Connect the Computer AC power cable to an available power outlet or power bar (not supplied).

2. Connect the 2000i AC  power cord to the country-specific AC cord in the accessory box. Then
connect this AC cord to an available power outlet or power bar (not supplied).
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Powering up the 2000i 

1. If the projector is not on, press the main power switch.

NOTE: The projector in the figure below is shown upside down, just as it’s installed in the 2000i.

VIDEO
INR

AUDIO

L/MONO

AUDIO OUT
S-VIDEO

IN
R

AUDIOPC CONTROL

AC IN

RGB OUT

L/MONO

RGB IN AUDIO

USB(PC)

Main Power Switch

                                                  Main Power Switch on Projector

2. At the front of the 2000i, press the power button on the computer.

3. Turn on the projector lamp by pressing the Lamp On button on the Control Panel (to the right of
the pen tray). 

The LED indicator beside this button flashes quickly for 60 seconds, and then remains steadily
illuminated when the projector lamp has powered up.

Lamp ON

On LED

  Lamp On Button on the Control Panel

When an image displays, adjust the computer power settings and the image alignment on the
interactive screen. Then install SMART Board software, configure the COM port, and perform a
brief orientation procedure. To do this, complete the procedures on the pages that follow.

NOTE: You should leave the computer and the projector on at all times (so the projector is either
in use, with the lamp illuminated, or in standby mode). However, you can set the computer to
save power during periods of inactivity. The following section describes how to do this.

Adjusting the Computer’s Power Settings to Preserve Your Lamp

For greater ease of use, you should keep the computer on all the time. However, to extend the life of
the projector lamp and the computer’s hard drive(s), you should also set the monitor (the interactive
screen) and hard drive(s) to automatically go into standby after a specified period of inactivity. If you
do keep the computer on all the time, restart it occasionally.

NOTE: You may prefer to shut the computer down at the end of the day. 



12 2000i-DVX Installation Guide

The projector is configured to shut down three minutes after no new input signal is received. For this
reason, you should avoid using the screen saver function on the computer. Of course, the only real
benefit of a screen saver – to avoid image burn-in, either on monitors or plasma displays – has no
bearing at all on a projected system.

During the three-minute shutdown period, the interactive screen turns black. If you want to use the
system again, you can restore the display by pressing any button in the Control Panel. At the end of
the shutdown period, the projector lamp turns off, and you must press the On button to restore the
system.

NOTE: You can't adjust the power settings on Windows NT 4.0 systems, so at the end of the day you
must leave on with full power or shut it down.

To adjust a computer's default power settings (Windows)

NOTE: This procedure may vary, depending on which version of the Windows operating system
you’re running.

1. Click the Start button on the Windows taskbar, point to Settings, and select Control Panel.

2. Double-click Display and click the Screen Saver tab.

3. Under Energy saving features of monitor, click the Settings (or Power) button. 

The Power Management Properties (or Power Option Properties) dialog box appears.

4. Select After 1 hour from the Turn off monitor list.

NOTE: This is a recommended setting. You can select any duration you want.

5. In the Turn off hard disks list, select the period of inactivity that must elapse before hard disk
shutdown. 

NOTE: For the above step, we recommend that you select After 2 hours. This extended time
period ensures that guest laptop presenters − or participants in lengthy meetings characterized
by large gaps in activity − do not experience an unexpected hard disk shutdown.

6. Click the Apply button and then click OK.

When the system reaches the period of inactivity specified in step 4, the computer stops sending
an RGB signal. If no other source is active, the projector goes into a three-minute shutdown
mode, during which time the screen turns blue (the no-input screen). After three minutes, the
projector lamp turns off and the screen turns black.

NOTE: To immediately restore the input signal from the computer during this three-minute
projector shutdown period, press any Control Panel button. This function is especially handy
when you're a passive participant in a lengthy data conference.
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Adjusting the Projected Image

CAUTION Do not move the blue ring that surrounds the customized projector lenses, even
though the NEC VT660K/VT560/VT465 User’s Manual states that you should use this
ring to obtain the best focus. You must disregard this information because mvoing this
ring may cause the lenses to separate. 

The Zoom lever on the projector has been modified to adjust image focus. Again,
contrary to the NEC VT660K/VT560/VT465 User’s Manual, the Zoom lever will not
adjust the image size on the screen.  

If the placement, size and shape of the projected image is less than optimal, you may need to
perform any of four adjustment procedures.

For the first three procedures (adjusting image roll, adjusting the image laterally and adjusting the
image size), you must watch the image on the back of the screen while making adjustments. You’ll
also need to remove the view port cover, which is attached with hook-and-loop fastener strips, to
access the adjustment hardware at the rear of the unit. 

For the final procedure (adjusting the image vertically), adjust the image while watching it from the
front of the unit.

To focus the image

1. Locate the focus lever, at the bottom of the upside-down projector. Use this lever rather than the
blue focus ring to adjust the focus. 

Do not move this ring!

Bottom View (Upside-Down)

Side View

Adjust the focus with this lever
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2. Using a 5/32" or 3/16" flat screwdriver, loosen the slot-head screw in the center of the focus
lever.
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Loosen this screw, adjust 
the focus lever and tighten.

3. Adjust the focus by moving the lever and then tighten the slot-head screw that you loosened in
the previous step.

To remove the view port cover

1. Grasp the view port cover in the middle of each short edge, and pull it away from the unit.

  

  Removing the View Port Cover

You can now access the top of the projector to perform the following image adjustment
procedures.

Lift from here Lift from here
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To adjust the image roll

1. Crouch behind the projector and look at the projected image through the view port.

  Position for Adjusting Image Roll

2. While carefully observing the bottom edge of the image at the right side, use the supplied 7/16"
nut driver to loosen or tighten the nut that’s located on the right side of the projector plate, as
required (see the following figure).

                                            Using the Nut Driver to Adjust Roll

Roll Adjustment



16 2000i-DVX Installation Guide

To adjust the image laterally

1. Crouch behind the projector and look at the projected image through the view port.

  Position for Adjusting the Image Laterally

2. Using the supplied 7/16" nut driver, loosen the two nuts that are located on the left side of the
projector plate.

                                   Using the Nut Driver to Adjust the Image Laterally

3. Slide the projector plate to the right or left, and then tighten the two nuts.
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Image Size Adjustment

To change the image size

1. Crouch behind the projector and look at the projected image through the view port.

  Position for Changing the Image Size

2. Using the security key (TR20 Torx®  tamper-resistant key) from the accessory kit, loosen the
three Torx M4 security screws that secure the projector to the projector plate. 

NOTE: You’ll find these screws on the top of the projector plate, one at the front of the projector
and two at the back. 

  Loosen the Three Hex Screws to Size the Image

To access the single screw at the front, you must reach through the view port to the front of the
projector, and maneuver the security key through the center access hole in the projector cover
(see the following figure).

3x
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  Location of Access Hole at the Front of the Projector

NOTE: As you maneuver the security key through the access hole, watch it from the back to see
when it engages with the screw.

3. Slide the projector backward or forward to alter the image size. 

4. When the image is a good size, tighten all three screws that you previously loosened.

NOTE: Screen Removed for Clarity

Access Hole for the Screw at the 
Front of the Projector
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Move Image Up or Down

To move the image vertically

1. Move to the front of the unit and crouch down, facing the screen.

  Position for Moving the Image Up or Down

2. Locate the Electronics Tray underneath the pen tray, and then locate a large access hole that’s
covered with a plastic cap on the right side of the Electronics Tray.

  

  Loosening the Bolt to Move the Image Up or Down

3. Remove the plastic cap that covers the access hole. If the cap seems tight, carefully pry it off with
a screwdriver, inserting the screwdriver into the small opening at the top of the cap.

4. Loosen or tighten the bolt inside the access hole with the supplied 7/16" nut driver to adjust the
image vertically.

Electronics Tray
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CAUTION Do not turn the small-mirror adjustment bolt more than three full turns in a clockwise
direction. Turning the bolt too far clockwise may crush the spring that is an essential
part of the adjustment mechanism.

5. Replace the plastic cap you removed in step 3.

Installing the Videoconferencing/Laptop Shelf

You can position the videoconferencing/laptop shelf just above the height-adjustment handle (for
laptop use), or higher up on the frame (for use with a videoconferencing camera). You can also install
the shelf on either side of the unit. 

  Shelf Height Option

To install the videoconferencing/laptop shelf

1. Remove the plastic hole covers at the location where you want to mount the shelf. 

  Removing the Hole Covers

Videoconferencing 
Height

Laptop Height
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2. Hook the shelf to the keyholes, and then push the shelf firmly down.

                                                          Attaching the Shelf

3. Push the captive thumbscrew at the bottom of the shelf into the thumbscrew hole and tighten.

Matching the Computer Resolution to the Projector Resolution 

It's very important that the computer and projector resolutions match so the projected image properly
fills the screen. Since the projector resolution is 1024 x 768 (XGA), you must ensure the computer
resolution is also set to 1024 x 768.

NOTE: If the computer resolution is set to anything other than this optimal resolution, you may not
see the entire image, or the image may be too small to fill the screen, even with further adjustments. 

To set your computer’s resolution to match the projector resolution (Windows
operating system)

NOTES

• You may need to perform the following procedure using your computer monitor, as resolution
differences can impair the visibility of the image on the interactive whiteboard screen.

• This procedure may vary, depending on which version of the Windows operating system you’re
running.

1. Click the Start button and then select Settings > Control Panel.

The Control Panel window appears.

2. Double-click Display.

Captive Thumbscrew

Keyholes



22 2000i-DVX Installation Guide

The Display Properties dialog box appears.

3. Click the Settings tab.

4. Move the slider to 1024 x 768.

5. Click the Apply button and then click OK.

6. Restart your computer, if required.

To set your Macintosh computer resolution to match the projector resolution

1. Click the Apple menu.

2. Click Control Panels.

3. Select Monitors.

The Monitors dialog box appears.

4. Click the Options button. 

5. In the Select a monitor setting list, select 1024 x 768, and then click OK.

Installing SMART Board Software 

The installation process should start automatically after you insert the SMART Board software CD
into your CD-ROM drive. Otherwise, install the software as follows.

To install SMART Board software for Windows operating systems

1. Insert the SMART Board software CD into your CD-ROM drive.

The SMART Board software setup program should start automatically. If it doesn't, select Start >
Run and enter x:\autorun.exe (where x: is your CD-ROM drive). Follow the on-screen
instructions to install SMART Board software. 

At the end of the installation, you can choose to put a shortcut to SMART Board software in your
Startup Folder. We recommend that you do so. Then the SMART Board tools will always be
open, and your interactive whiteboard will be fully functional when you start up your system.

2. Click Yes to insert a shortcut to SMART Board software in the Startup folder, or click No to
prevent SMART Board software from starting whenever you start up your system.

To install SMART Board software for Macintosh computers

1. Insert the SMART Board software CD into your CD-ROM drive.

2. Double-click the SMART Installer icon.

The SMART Installer window appears.

3. Click the Continue button and then follow the instructions on your screen.

Configuring and Orienting the Interactive Whiteboard 

After you install SMART Board software, you must configure and orient the interactive whiteboard.

You may need to specify whether the serial or USB port on the host computer connects to the
interactive whiteboard. If you're running SMART Board driver version 6.0 (or later), the COM port
configuration process is entirely automatic, unless: 

• the Windows operating system you're running does not perform plug and play (e.g., Windows NT
4.0 or ME) 
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• the Windows operating system fails to announce that it has Found New Hardware

Then you must manually configure the COM port. After you do this, you should orient the interactive
whiteboard to ensure accurate tracking of your finger or a pen tray tool. If the projected image
becomes misaligned, you must perform the orientation procedure again.

To select a COM port for the interactive whiteboard

1. Select Start > Programs > SMART Board Software > SMART Board Tools.

2. Click the SMART Board icon in the system tray and select Control Panel.

The SMART Board Control Panel appears.

3. On the Boards tab, click the Connect button.

The Select COM Port dialog box appears.

4. If you know the COM port to which the SMART Board interactive whiteboard is connected, you
can type it or select it from the COM port list. Then click the Select button. 

OR

If you're unsure of the correct COM port, click the Detect SMART Hardware button to initiate
hardware detection. SMART board software searches your COM ports for the presence of an
attached interactive whiteboard.

The interactive whiteboard is now touch sensitive. You can write over any projected application
with a pen tray stylus.

To orient the interactive whiteboard

Click the SMART Board icon and select Orient, and then follow the on-screen instructions. You can
also access this feature by clicking the Orient button on the Boards tab of the SMART Board Control
Panel.

To change the orientation precision

1. Click the SMART Board icon and select Control Panel.

The SMART Board Control Panel appears.

2. On the Boards tab, click the Advanced button.

For Mac OS X computers, the Edit Advanced Settings dialog box appears.

For Mac OS 9.x computers or earlier, the Pick the Orientation Precision dialog box appears after
you click the Orient button. Proceed to step 4.

For Windows operating systems, select Board Settings from the shortcut menu that appears.

The Edit Advanced Board Settings dialog box appears.

3. Click the Pick the Orientation Precision tab.

4. Select the Orientation level you prefer.

5. Click the Apply button, and then OK (or Next for Mac OS 9.x computers or earlier).

6. Click the Orient button.

7. Follow the on-screen instructions. Press on each cross that appears with your finger or stylus at a
90° angle to the screen. 
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IMPORTANT: Keep your finger straight as it approaches the screen. Press it firmly on each
cross, and keep it straight as you pull it away from the screen.

8. Test the orientation by dragging your finger across the screen. The cursor should track your
finger very closely and appear directly beneath the center of your fingertip.

Calibrating the Cameras (DViT Technology)

With DViT technology, small cameras that are located in the corners of the interactive whiteboard
frame detect contact with the screen. For the screen to function properly, these cameras must be
precisely calibrated so the computer can provide an accurate and appropriate response to screen
contact.

You should recalibrate the cameras (and re-orient the screen) if areas of the screen have inaccurate,
erratic or absent touch sensitivity, or if the electronic ink that appears when you write on the screen is
jagged, broken or even absent.

To recalibrate the cameras

1. Press the SMART Board icon in the system tray, and select Control Panel. 

The SMART Board Control Panel opens.

2. On the Boards tab, press the Advanced button.

The Edit Advanced Board Settings dialog box opens.

3. Press the DViT Settings tab.

4. Press the Calibrate button.

The four-point calibration screen appears.

5. Press and hold your finger on the center of each target until the target moves.

After you press the final target, a message appears, followed immediately by the orientation
screen.

6. Complete the orientation procedure.

7. Press OK.

Connecting a Guest Laptop
You can connect and control a laptop presentation by touching the screen only if you:

• purchase and install the X-Port 20 switch option for the 2000i

• install SMART Board software on the laptop

The X-Port 20 unit is an RS-232 serial switch for establishing a serial connection with the laptop,
enabling the laptop user to both write over top of the displayed laptop image with a pen tray stylus
and control the contents of the laptop by touching the interactive screen. In addition, it allows you to
switch between the laptop, the resident computer and a VCR/DVD player using the Control Panel at
the front of the 2000i. If a guest laptop requires a USB connection to the 2000i, purchase the optional
USB-ADP cable from SMART Technologies to convert USB to serial.

Complete instructions for installing the X-Port 20 switch and connecting a guest laptop are in the
X-Port 20 Switch Installation Guide that comes with the X-Port 20 option kit.

Connecting a VCR or DVD Player
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You’ll need the following cables to connect a VCR or DVD player to the 2000i: 

• an RCA composite video cable or an S-video cable

• standard red and white RCA stereo audio cables

To connect a VCR/DVD player to the 2000i

1. Power down the projector.

2. Connect the yellow RCA video connector on an RCA composite video cable (not provided) to the
Video Output jack on the VCR/DVD player. This jack may be labeled “To Monitor”.

3. Plug the other end of the cable into the Video IN connector on the projector.

     Connecting the Video Cable from the VCR/DVD Player to the Projector
NOTE: If you're using an S-video cable, connect it to the S-video OUT connector on the
VCR/DVD player, and then plug the other end into the S-video IN connector on the projector. With
an S-video cable, you can’t use the Control Panel to switch the projector to the VCR/DVD player
input. Instead, you must use the projector remote control to switch to the S-video input.

4. Connect standard red and white RCA stereo audio cables (not provided) from the RCA Audio
outputs on the VCR/DVD player to the two Auxiliary Audio IN jacks on the rear of the 2000i.
Keep your right and left channel connections correct for stereo sound. 

Connecting the Audio Cables 

Video IN

Composite Video Cable 
from VCR or DVD Player

VIDEO
INR

AUDIO

L/MONO

AUDIO OUT
S-VIDEO

IN
R

AUDIOPC CONTROL

AC IN
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RGB IN AUDIO

USB(PC)

S-Video IN

Computer 2
Audio

Auxiliary
Audio In

Audio
Out

Connect red and white RCA 
audio cables here

Comput er  2
Audi o

Auxi liary
Audi o In

Audi o
Out
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NOTE: You can't connect the audio cable from both a VCR and a DVD player using the RCA
jacks because the Connection Panel can only accommodate one external audio source that uses
RCA connectors at a time. 

5. Connect the power cable to an available outlet or power bar (not supplied). 

6. Turn on the projector.

7. Press the VCR/DVD Player button on the Control Panel.

NOTE: If you connected the VCR or DVD player using an S-video cable, nothing happens when
you press the VCR/DVD Player button on the Control Panel. Instead, you must press the S-video
button on the projector or on the projector’s remote control to switch the projector input.

  VCR/DVD Player Button on the Control Panel

8. Turn on the VCR/DVD player and press the Play button. 

Connecting an External Sound System

To deliver preamplified (or low level) sound to an external room sound system

Connect standard red and white RCA audio cables (not provided) from the RCA Audio inputs on the
external sound system to the two Audio OUT jacks on the rear of the 2000i. Keep your right and left
channel connections correct for stereo sound.

  Connecting Audio Cables from an External Sound System

VCR/DVD Player Button

Computer 2
Audio

Auxiliary
Audio In

Audio
Out

Connect red and white RCA audio 
cables to external sound system here

Comput er 2
Audi o

Auxi liary
Audi o In

Audi o
Out



2000i-DVX Installation Guide   27

Connecting an External Monitor or Projector

To direct the RGB output from the host computer or guest laptop to an external
projector or monitor

Connect an HD DB15 video cable (not provided) from the external projector or monitor to the RGB
OUT port on the back of the projector. This connection is for RGB output only.
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Basic Operations

This section shows you how to:

• Start up and shut down the 2000i (page 28)

• Adjust the height of the interactive whiteboard (page 31)

• Adjust the volume (page 32)

• Change the projector display source (page 33)

• Use the interactive whiteboard (page 34)

Starting up the 2000i

You should keep the projector on at all times. However, to conserve the projector lamp, press the
Lamp Off button on the Control Panel at the end of your session (or at the end of the day). For ease
of operation, you should also keep the computer on all the time. By doing this, you can start up the
2000i by restoring power to the projector lamp (press the Lamp On button on the Control Panel) and
then entering your user name and password at the logon screen.

NOTE: To preserve the computer's hard drive(s) and the projector lamp, you may want to put the
computer hard drive and the monitor (interactive screen) into standby mode. Refer to page 11 for
instructions.

To start up the 2000i

1. If the screen is black, press the Lamp On button on the Control Panel to power up the projector
lamp. The On LED indicator should blink quickly for approximately 60 seconds, and then remain
illuminated when the lamp is fully powered up. 

Lamp On

On LED

2. If you see a logon screen, use the connected keyboard to enter your logon ID and password, and
then press the OK button.

OR

If the screen turns from black to blue – and no logon screen appears – you may need to power
up the computer or restore it from a standby setting by pressing the computer’s reset button.

See the next page for possible startup scenarios.
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Startup Scenarios

If your 2000i is situated in a multi-user room, you may sometimes find the unit in a non-operational
state. The following table describes what you may need to do to restore the 2000i to a fully
operational state.

What You See What You Should Do
• Screen is black

• On LED is blinking
intermittently (short
flashes between
long pauses)

The projector is in standby mode (with the lamp off).

• Press the Lamp On button on the Control Panel. The On LED indicator
blinks quickly as the lamp warms up, and, after approximately 60 seconds,
either a blue "No Input" screen appears (see immediately below) or the
screen is restored to its last active state.

• Blue "No Input"
screen

• On LED is steadily
illuminated

The projector lamp is powered up, but the computer is either off or in standby
mode, or you’ve selected an inactive display source.

• Press a key on the connected keyboard to activate the computer. The logon
screen appears.

OR

Press a source button on the Control Panel to change to an active source.

If the blue "No Input" screen remains:

1. Turn the computer on (or press the computer’s reset button). The logon
screen appears.

2. Log on as usual (using the connected keyboard).

• Screen is black

• On LED is blinking
slowly

No action is necessary. The projector lamp is in the process of powering up, and
the logon screen will appear after approximately 60 seconds. 

• Screen is black

• Off LED is blinking
rapidly

The projector lamp is in reversible standby mode. If you don’t press a button to
instantly restore the image, after three minutes the LED indicator will blink slowly
for 60 seconds as the lamp powers off and cools down. At this point, follow the
first set of instructions in this table to restore the 2000i to an operational state.

• Logon Screen The projector lamp is still on, so you can log on as usual (using the connected
keyboard).

• On LED continues to
blink intermittently,
even though you
pressed to the Lamp
On button to start
the system

Projector problems are preventing a normal projector lamp warm-up. Examine
the projector status LED indicator, and then consult the troubleshooting section
of the NEC VT660K/VT560/VT465 User’s Manual.

• The Off and On
LEDs are both
flashing constantly

The system can’t detect a projector. Check the NEC VT660K/VT560/VT465
User’s Manual to make sure the projector is connected properly. 
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Putting the 2000i on Standby

For normal operation, you don’t need to power down the computer or the projector at the end of a
session or at the end of the day. Just log off the computer (for security) and then turn off the projector
lamp (to conserve its life) by pressing the Lamp Off button on the Control Panel. 

NOTE: If you won’t use the 2000i for an extended period of time, you should power down the
computer and the projector.

To put the 2000i on standby

1. Log off by selecting Start > Shut Down.

NOTE: Logging off enhances system security. It also gives users a consistent initial interface –
the system logon screen – when they power up the projector lamp. 

2. Press the Lamp Off button to put the projector into reversible standby mode for three minutes.

  

  Lamp Off Button on the Control Panel

While the screen appears black, the projector lamp remains on so you can immediately restore
the image (if necessary) by pressing any button on the Control Panel. After three minutes, the
lamp powers off and cools down for 60 seconds.

To skip the three-minute reversible period, press and hold the Lamp Off button for three
seconds. Release the button and the lamp powers off and enters a 60-second cooldown period.

Perform this procedure at the end of a meeting or presentation and at the end of the day. If you
prefer, you can also shut down the computer. However, we recommend simply logging off rather
than powering down the computer.

To power down the projector (if unused for an extended period)

1. Log off (as described above) and power down the computer.

2. Press the Lamp Off button on the Control Panel. 

The Off LED indicator blinks rapidly for three minutes (reversible standby), and then slowly for
approximately 60 seconds while the lamp cools down. When the lamp is off, the On LED indicator
blinks very slowly.

OR

Press and hold the Lamp Off button for three seconds. The lamp immediately powers down and
enters a 60-second cooldown period. 

3. When the cooling fan stops, flip the power switch on the back of the projector. 

4. Disconnect the 2000i power cable from the wall power outlet.

Lamp Off
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Adjusting the Height of the Interactive Whiteboard

It’s easy to raise or lower the interactive whiteboard to accommodate users of different heights (even
while the system is in operation), so anyone can comfortably touch or write on the screen. The 2000i
has a height adjustment range of 14" (35.6 cm).

Turn the handle to adjust the top of the screen from a lower limit of 69" (175.3 cm) from the floor to a
maximum height of 83" (210.8 cm) from the floor. When you reach the top and bottom limits of the
adjustment range, you can’t turn the handle any further. 

To gauge the height of the unit as you turn the height adjustment handle, or to adjust it to a particular
height, watch the height finder that is located on the side of the unit, just above the handle.

  

Height Finder

                                                  Location of the Height Finder

NOTE: If the computer on the storage tray is unusually tall, be careful not to lower the interactive
whiteboard on top of it.

To raise the screen

Turn the height adjustment handle in a clockwise motion to raise the screen. The maximum height is
83" (210.8 cm).
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Turn clockwise to 
raise the screen

Height Adjustment 
Handle

Turn counterclockwise to 
lower the screen

  Adjusting the Screen Height

To lower the screen

Turn the height adjustment handle in a counterclockwise motion to lower the screen. The minimum
height is 69" (175.3 cm) from the floor. Be careful not to lower the unit on top of your computer.

Adjusting the Volume

You can adjust the volume for the active display source, independently of the other sources. When
you switch to another input source, the 2000i retains the settings you made for the first input source
(for when you switch back). 

Volume Up

Volume Down

To adjust the volume

1. Press and hold the Volume Up (  +) button on the Control Panel to increase the volume for
the current source.
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2. Press and hold the Volume Down (  –) button on the Control Panel to decrease the volume
for the current source.

To restore the default volume level (no sound)

Press and hold both Volume buttons simultaneously.

To fine-tune the projected image

When you first use the projector, you may need to fine-tune the projected image. To automatically
optimize the image in RGB mode, press the Auto Adjust button on the projector’s remote control (or
on the projector). This will eliminate vertical banding, flickering, video noise, dot interference and
cross talk, and may be necessary the when you connect the computer for the first time.

Changing the Display Source for the Internal Projector

You can change the video and audio input source for the internal projector and cabinet audio
amplifier using the three source buttons on the Control Panel. Choose from the host computer, a
connected guest laptop or external computer (X-Port 20 switch option only) and a VCR or DVD
player. When the internal computer source is active, you can also open Notebook software and the
SMART Board tools by pressing the Notebook software button on the Control Panel.

Internal (Host) Computer 

Guest Laptop

VCR/DVD Player
Notebook 
Software

NOTE: Source switching takes a few seconds, and during that time all buttons on the Control Panel
are disabled.

To switch to the connected VCR or DVD player

Press the VCR/DVD Player button on the Control Panel.

NOTE: You can't use the VCR/DVD Player button to switch to a VCR or DVD player that’s connected
by an S-video cable. You must use the projector remote control to switch to an S-video source. 

To switch to the internal computer 

Press the Internal Computer button on the Control Panel.

To switch to a guest computer (X-Port 20 switch option only)

Press the Guest Laptop button on the Control Panel. 
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NOTE: You must have the X-Port 20 switch installed to switch to a connected guest laptop or
external computer. For complete details regarding guest laptop connections and switching, see the X-
Port 20 Installation Guide, which is included in the kit.

To switch to Notebook software

Press the Notebook button on the Control Panel. (Press it again, and Notebook software will
minimize.)

NOTE: For Notebook software to appear, it must first be installed and running on the internal
computer (see page 22) or guest laptop. The internal computer source must also be the active
source. For information on using Notebook software, see Using Notebook Software below.

To open the Floating Tools

Press the Notebook button and hold for four seconds. 

OR

Press the SMART Board icon and select Floating Tools.

NOTE: For the Floating Tools to appear, SMART Board software must first be installed and running
on the internal computer (see page 22) or guest laptop. The internal computer source must also be
the current active source. For more information on using the Floating Tools, see Using the Floating
Tools, on page 34.

Using the SMART Board Interactive Whiteboard 

After you install SMART Board software on the host computer, and then configure and orient the
interactive whiteboard, you're ready to use the 2000i. To get the most from your interactive
whiteboard, you should have both the SMART Board tools and Notebook software open and running. 

SMART Board Tools

The SMART Board tools provide you with annotation and tool-configuration capabilities, as well as
SMART Video Player, SMART Recorder, and the SMART Keyboard (the on-screen keyboard). You
must have the SMART Board tools running to use the pen tray styluses and eraser. In other words, if
you want to write on your interactive whiteboard with a pen tray stylus, make sure the SMART Board
icon appears in the system tray (Windows operating system) or menu bar (Macintosh computer).

  SMART Board Tools 
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Using Notebook Software

Notebook software includes many object-creation tools that allow you to create a variety of
annotations and import graphics, text, clip art and entire files from any other application into your
Notebook file. But Notebook software is much more than just an electronic flip chart for displaying
presentations or capturing notes in a brainstorming session. It also serves as a receptacle for
anything you write on the interactive whiteboard over any application. 

If you want to capture the annotations you’ve made over other programs, select Screen Capture
from the View menu and then minimize the Notebook software window. A three-button Screen
Capture toolbar will float on top of all your applications. You can now capture your annotation with a
press of a button. Macintosh computer users can access the same annotation-capture capability from
the SMART Board Tools menu. Notebook software automatically places a newly captured image on
a new page of the current Notebook file.

To write into Notebook software, leave the Notebook software window open and maximized. If you
want an even larger area for writing or brainstorming, select Full Screen from the View menu. 

Using the Floating Tools 

The Floating Tools are a virtual version of the pen tray tools. Press the Pen button on the Floating
Tools palette, for example, and your next contact with the interactive whiteboard produces electronic
ink. In addition, the default palette includes a number of tools that you won’t find on the pen tray, such
as tools for producing a right-mouse click, displaying a large pointer, producing a spotlight, capturing
your annotations and restoring cleared annotations. You can edit the default palette of tools and save
this customized palette in a user profile that you can activate each time you use the interactive
whiteboard.

Right-ClickPen

Left-Click

Highlighter Eraser

Spotlight

Screen Pointer Restore/Clear Annotations

The Restore/Clear Annotations Button

The Restore/Clear Annotations button is a great reason to keep the Floating Tools open. When you
write something on the interactive whiteboard, the button is in its Clear Annotations state; as soon
as you delete an annotation, the button changes to Restore Annotations.

Let’s say you’ve written an important note, but your elbow grazes the interactive whiteboard as you
turn towards your audience: the annotation you just made disappears. Just press the Restore
Annotations button and your note reappears. If you haven’t activated the Floating Tools, don’t worry.
Press the Notebook button on the Control Panel for about four seconds (just until the Floating Tools
appear), and then press the Restore Annotations button. The last cleared annotation – in this case,
the one you accidentally lost – reappears. 

Clear Annotations

Restore Annotations
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Enabling/Disabling the Multipointer Mode

In the Multipointer mode, two people can write on the interactive screen simultaneously. After the first
person picks up a pen tray stylus, the other person can use their finger or another stylus to write in
the same color.

To enable/disable the Multipointer Mode

1. Press the SMART Board icon in the system tray and select Control Panel.

The SMART Board Control Panel opens.

2. On the Boards tab, press the Advanced button.

The Edit Advanced Board Settings dialog box opens.

3. Press the DViT Settings tab.

4. Select the Multipointer Mode check box.

5. Click Apply and then OK.

Calibrating the Cameras

With DViT technology, cameras that are located in the corners of the interactive whiteboard frame
detect contact with the screen. For the screen to function properly, you must precisely calibrate these
cameras and orient the interactive whiteboard so the computer can provide an accurate and
appropriate response to screen contact.

You should calibrate the cameras and orient the screen if areas of your screen do not have touch
control, or have erratic touch control. As well, perform the procedure below if the electronic ink that
appears when you write on the screen is jagged, broken or doesn't appear at all.

To calibrate the cameras and orient the screen, access the Advanced settings of the SMART Board
Control Panel on a computer running the Windows 98, 2000, Me, XP or Windows NT operating
system.

To calibrate the cameras

1. Press the SMART Board icon in the system tray and select Control Panel.

The SMART Board Control Panel opens.

2. Press the Advanced button.

The Edit Advanced Board Settings dialog box opens.

3. Press the DViT Settings tab.

4. Press the Calibrate button.

The four-point calibration screen appears.

5. Press the center of each target and hold until you hear a beep.

After you press the final target, a message appears, followed immediately by the orientation
screen.

6. Complete the orientation procedure.

NOTE: Unlike the calibration screen, you will not hear a beep after pressing each target on the
orientation screen.

7. Press OK.
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Maintenance

Cleaning the Interactive Whiteboard and Other Components

• Clean the interactive whiteboard surface on a regular basis with a standard glass cleaner.
Otherwise, dust may build up, adversely affecting the operation of the 2000i.

• Do not spray the glass cleaner directly onto the screen surface. Instead, spray it lightly on a cloth
and then gently wipe. The 2000i uses digital cameras that are located inside the frame. If you
allow excess glass cleaner to flow into the crack between the frame and the writing surface, the
fluid could damage the cameras.

• Before you clean the interactive whiteboard, log off the computer. If you touch the screen when
the computer is in any other state (e.g., with a program open or at the desktop), you may activate
program components or scramble desktop icons. After you log off, put the projector into standby
mode so you can easily see dirt and streaks. 

• Remove marks made with a permanent marker by completely covering them with the ink from a
dry-erase marker (not a low-odor marker). Then wipe with a soft cloth. Dry-erase ink contains
solvents that work to remove permanent ink. If any trace of the original permanent ink remains,
spray the area with standard glass or whiteboard cleaner and wipe clean.

• Periodically dust the mirrors and unit components using a soft cloth. To clean the mirrors, use a
standard, alcohol-free glass cleaner.

• If your eraser pad becomes heavily soiled, you may simply want to replace the pad. This is
easily done and you can order eraser pads from your dealer in packs of five or ten (Order No.
ERA-PAD-5 or ERA-PAD-10). 

• The back of the screen is well protected from handling by its location on the inside of the unit.
However, if it must be dusted, or if a mark has been made on its surface, dab it gently with a soft
cloth that’s sprayed with standard, alcohol-free glass cleaner. Do not apply the cleaner directly to
the surface.

CAUTION Do not, under any circumstances, apply isopropyl alcohol, water or acetone to the
rear surface of the interactive screen. These fluids could damage the diffusion
coating, resulting in a permanent deterioration in display quality.

Cleaning the Projector
Before you clean the projector, unplug it.

Periodically clean the projector casing with a damp cloth. If it is heavily soiled you can use a mild
detergent, but don't use strong detergent or a solvent, such as alcohol or thinner. Use a blower or
lens paper to clean the lens, being careful not to scratch or mar the lens.
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Cleaning the Filter and Clearing the Filter Cleaning Message

Clean the air-filter sponge with a vacuum after every 100 hours of operation (more often in dusty
conditions), as described on page E-31 of the NEC VT660K/VT560/VT465 User’s Manual. 

A “Please Clean Filter" message from the projector appears on the bottom of the screen after every
100 hours of operation. However, after you clean the filter this message will not automatically
disappear, so you must use the projector’s remote control to clear the filter usage meter, as follows:

1. Press the Menu button on the remote control.

2. Select Default > Clear Filter Usage.

The meter returns to zero. You won't receive another "Please Clean Filter" message for another 100
hours.

Replacing the Projector Lamp and Filter 

Replace the lamp when you see this message: "The lamp has reached the end of its usable life.
Please replace the lamp." To do this, order the NEC VT60LP standard lamp, which is available from
NEC or SMART. Do not use any other lamps.

In general, you should replace your projector lamp after 2000 hours of normal mode operation or
3000 hours of eco-mode operation, as the projector will turn off automatically and go into standby
mode after 2100 hours (normal mode) or 3100 hours (eco mode).

To find out how many hours of lamp use remain, go to the projector menu (press the Menu button on
the remote control or projector) and select Information > Page3 > Remaining Lamp Time.
Replacing the used lamp with a new lamp automatically clears the lamp usage hours. When you
replace the projector lamp, you should also replace the projector filter, which you'll automatically
receive with the replacement lamp.

You'll find instructions for replacing the lamp on page E-30 in the NEC VT660K/VT560/VT465 User’s
Manual.

WARNING After you turn off the projector, allow at least one minute to elapse before you
unplug it. Do not touch or replace the projector lamp (which will be very hot)
for at least an hour.

Après avoir éteint le projecteur, attendez au moins une minute avant de le
débrancher. Attendez au moins une heure avant de toucher ou de remplacer
la lampe du projecteur (qui sera très chaude).

Stecken Sie den Projektor für mindestens eine Minute nach dem Abschalten
nicht aus. Berühren oder ersetzen Sie die Projektorlampe (die sehr heiß sein
wird) nicht vor Ablauf einer Stunde.
プロジェクターの電源を切った後、最低でも 1
分間はプロジェクターのプラグを抜かないでください。プロジェクターのランプは非
常に熱くなりますので、最低でも 1 時間は触ったり交換したりしないでください。
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CAUTION Never touch the back of the screen or brush against it with your head while
you're examining the internal cabinet components. If you do smudge this
surface, lightly spray alcohol-free glass cleaner onto a soft cloth and lightly
dab the affected area to remove the marks. Never apply isopropyl alcohol,
water or acetone, as these fluids will damage the diffusion coating and
permanently reduce the display quality.

WARNING

     

To avoid an electric shock, do not remove any screws on the projector except
the two lamp-case screws.

Pour éviter tout risque de choc électrique, ne retirez aucune vis, à l’exception
des deux vis d’accès aux lampes.

Para evitar descargas eléctricas, no quite ningún tornillo excepto los de las
dos lámparas.

Um einen elektrischen Schlag zu vermeiden, dürfen Sie mit Ausnahme der
beiden Lampengehäuseschrauben keine Schrauben entfernen.
感電の恐れがありますので、ランプ ケースの 2
つのねじ以外に、ねじは取り外さないようにしてください。
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Customer Support

Contacting SMART Technical Support

SMART’s Technical Support team welcomes your call. However, you may first want to contact your
local reseller if you experience any difficulty with your 2000i, as they may be able to solve the
problem without delay. 

All SMART products include free telephone, fax and e-mail support. 

Telephone: 1.866.518.6791 (toll-free in Canada/U.S) or +1.403.228.5940 (all other
countries)
(Available 7 a.m. − 6 p.m. Mountain time from Monday to Friday)

Fax: +1.403.806.1256

E-mail: support@smarttech.com

Website: www.smarttech.com/support

When you phone Technical Support, it will be helpful if you have access to your 2000i during the call.
The support representative may ask you for the following information:

• the serial number of the unit

• the version of the software that’s causing the problem and the version of your computer’s
operating system (if applicable) 

General Inquiries

Main Switchboard: 1.888.42.SMART (toll-free in Canada/U.S.) or +1.403.245.0333 (all
other
  countries)

Fax: +1.403.228.2500

E-mail: info@smarttech.com

Address: SMART Technologies Inc.
Suite 300, 1207 – 11th Avenue SW
Calgary, AB  CANADA  T3C 0M5

Returning Defective Merchandise

All Rear Projection SMART Board 2000i interactive whiteboards are covered by a two-year limited
equipment warranty. The integrated projector is also covered by a two-year limited equipment
warranty. To return defective merchandise, call SMART Technical Support. You will receive the
appropriate Return of Merchandise authorization and instructions for transporting your 2000i to an
authorized service center.

Warranty Shipping Charges

Transportation charges that are incurred from warranty service are paid as follows: You are
responsible for transporting the system to the service center, and SMART pays return shipping via
ground service on any product that’s returned for service within the warranty period. If you request a
rush order, any associated charges are billed to you. Read the warranty that was included with your
2000i for details.
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NOTE: After the warranty period, you are responsible for transporting the product to and from the
service center.

Registration

A User Registration card was included with your 2000i. To help us serve you, fill in and mail this card
to SMART Technologies Inc. or register online at www.smarttech.com/registration.

Sending Feedback

You can help us improve our documentation by e-mailing your comments to
TechnicalDocumentation@smarttech.com. We’d love to hear from you!

Obtaining More Information about Your Product

Visit www.smarttech.com/support to:

• download PDF versions of our user guides, installation instructions and more

• read technical bulletins, FAQs and tips

• troubleshoot a problem

• explore our resource centers to learn about conferencing and room control systems
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